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LNG Tank Design 
Checks 
The LNG Tank System carries out design checks to supported design codes for 
specified load combinations.  

Its use requires the MicroSoft Excel spreadsheet application to be installed in advance 
for full functionality as certain applications may use it during the design or reporting 
process. For example, the Wizard imports the spreadsheet template for design load 
combinations. 

Due to the low temperature of LNG, a thermal analysis requiring solid elements has to 
be performed and this often causes difficulties for load combinations that are based on 
structural results when the structural analysis is performed using shell elements. The 
LNG Tank System imports the temperatures and temperature gradients that are 
obtained from thermal analysis using solid elements into shell elements and allows all 
required load combinations to be assembled in a single model, to enable design check 
results to be obtained in an efficient way. 

This manual focuses on the procedures involved in performing design checks using the 
LNG Tank System. A separate manual titled ‘LNG Tank System: Part 1 – Tank 
Wizard’ provides details of modelling concepts used to build the range of models 
supported.  

User inputs shown in the manual ‘LNG Tank System: Part 1 – Tank Wizard’ are used 
in this manual unless otherwise stated. 
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Base Model 
Preparations 

User Inputs 
Select the menu item LNG Tank >Tank Definition… 

The required user inputs for this model are as marked in [Fig1] 

 

Fig 1 User Input for a Base model for design check  
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Fig 2 User Inputs for a Base model for design check including  
non-structural masses to Eigenvalue Analysis  

To include non-structural masses to eigenvalue analysis, 2D beam-stick seismic option 
should be ticked and non-structural masses should be defined.  
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Fig 3 User Inputs for a Base model for design check including  
wall stages to Staged construction/ CRSH Analysis  

To include wall stages to Staged construction/ CRSH analysis, Wall construction stages 
should be defined.  

Following user inputs should be defined.  

 Height(H) [m] : inputs the height of each wall lot. This value should be a 
positive.  

 Stage Y/N : input ‘Y’ if a separate stage should be created for the wall lot in the 
model. Otherwise input ‘N’. However, if the input value is ‘N’ for wall ID “1”, 
it is assumed that the wall lot 1 is activated together with the base annular part 
as shown in the Fig 4 The stage of activating wall lot 1 when ‘N’ for ‘Staged 
Y/N’.  
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Fig 4 The stage of activating wall lot 1 when ‘N’ for ‘Staged Y/N’ 

 

Fig 5 User Inputs for a Base model for design check including  
openings to Staged construction/ CRSH Analysis  

To include openings to Staged construction/ CRSH analysis, ‘Openings’ should be 
defined.  

Complete all the inputs and click OK to save the data with the name ‘Tnk1’. 

A Reinforcement and Prestress tendon arrangement is not required to build the 
corresponding model.  
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Build Base Model 
The Base Model for a design check can be built by selecting the menu item LNG 
Tank> Create 3D Shell Model… 

 

Fig 6 LNG Tank for a Base Model for Design Check 

Roof construction plan 
4 options are available which are ‘Single layered roof 1’, ‘Single layered roof 2’, 
‘Layered roof option 1’ and ‘Layered roof option 2’, based on the construction plan for 
the roof. The description under ‘Construction scenario’ group box will be updated upon 
the selection change. 

Roof first stage thickness (ratio) 
The roof thickness for 1st build will vary according to this value in the staged 
construction analysis model. 
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Initial prestress for ringbeam (ratio) 
The % of ringbeam PS that will be applied when the construction scenario is 
‘Ringbeam 1st PS’. 

Initial prestress for base slab (ratio) 
The % of base slab PS that will be applied when the construction scenario is ‘Base slab 
1st PS’. 

• Enter the model file name, and set the element size to 2.0. The other values as 
shown in [Fig 6].  

• Enter 10 for Number of Eigenvalues. Tick the ‘Include non-structural masses’ 
checkbox to include non-structural masses to eigenvalue analysis.  

• Select 4 for Number of buttresses, 1 for Extrude thickness and 5 for Buttress 
width. 

• Roof construction plan is set to ‘Single layered roof 1’. Initial prestress for 
ringbeam is set to 0.5 and Initial prestress for base slab is set to 0.5. Initial 
Prestress amount for Ringbeam and Base slab will also vary at the ‘Ringbeam 
1st PS (staged)’ and ‘Baseslab 1st PS (staged)’ in staged construction analysis 
model.  

Mesh  
The elements as shown below, with a maximum element size less than 2.0m as per user 
input. Quadratic shell elements (QTS8) are used. 

  

Fig 7 Mesh Arrangement and Geometric Properties for a Base Model for Design 
Check 
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The element local axis can be displayed as shown below. The wizard produces 
elements having a local x axis in the horizontal direction for the Wall and Roof.  The 
element shape in the Slab cannot be regular due to the variable pile arrangement hence 
the local axis of the elements for the Slab is not consistent. 

 

Fig 8 Element Local Axis in a Base model for design check  

Geometric Properties 
Geometric properties are defined as per user inputs illustrates how properties were 
defined for varying sections at the edge of the roof.  The variation dataset can be 
reviewed from the Utilities treeview. 

  
Fig 9  3D Shell Model for Base model for design check  
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Fig 10 Geometric Properties for Roof in Base model for design check 

 

 
Fig 11 3D Shell Model Thickness Variation at Roof and Slab 

Buttresses 
Buttresses can be included in the model with separate surfaces accepting separate 
geometric and material properties. The number of buttresses that can be defined is 0, 2, 
3, 4 or 6. 
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Fig 12 Base Model for Design Check including buttresses 
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Fig 13 User Input for the Number of Buttresses in a Base model for design check 

 

Fig 14 Buttress Definition for a 3D Shell Model 
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Groups and Materials 
The main groups created are named Roof, Wall, and BaseSlab. Two sets of dummy 
elements, which work as rigid links between the Roof and Ringbeam, and Wall and 
BaseSlab., are grouped separately, to aid with results-processing. 

 
Fig 15 Groups in a 3D Shell Model 

After user input, material properties are assigned to relevant members. 

 

Fig 16 Material Assignments in a 3D Shell Model 

Support Conditions 
Three different types of support conditions can be defined from Support(3D) tab in 
Tank Definition.  
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Use Support (2D) conditions 
This option is only available when either ‘Fixed Support’ or ‘Regular Support’ is set 
for Support type in Supports(2D) > Tank Definition. The same support condition 
defined in Support (2D) will be defined and assigned to Base model for design check.  

Regular Support 
The regular stiffness (stiffness per unit area) must be stated. A spring support will be 
assigned to all the bottom line of slab.  

If ‘3D shell structural’ option is chosen in Tank Definition, following two options are 
available.  

Simplified foundation 
The stiffness of each pile should be defined as shown in [Fig ]. The spring support will 
be assigned to each of pile locations. The Wizard accepts two sets of support stiffness 
(horizontal and vertical); one for crosswise piles and the other for circumferential piles. 
If the pile stiffness is different for each pile location due to the ground condition, it can 
be modified from the Modeller interface by defining different support conditions. If the 
crosswise pile coordinates are zero, then the model does not include crosswise piles 
and only includes circumferential piles.  

The spring stiffnesses are converted into N/m unit in LUSAS Modeller. 

Detailed foundation  
The stiffness of each pile should be defined as shown in [Fig 21]. The spring support 
will be assigned to each of pile locations. The Wizard accepts two sets of support 
stiffness (horizontal and vertical); one for crosswise piles and the other for 
circumferential piles. If the pile stiffness is different for each pile location due to the 
ground condition, it can be modified from the Modeller interface by defining different 
support conditions. If the crosswise pile coordinates are zero, then the model does not 
include crosswise piles and only includes circumferential piles.  

The spring stiffnesses are converted into N/m unit in LUSAS Modeller. 
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Fig 17 Support Definition in a Base model for design check 

 

 

Fig 18 Support Condition for a Base model for design check  
(Pile Support / Regular Support) 



Build Base Model 

17 

Loadings 
28 loadcases are created in a Base model for design check. Wind load can be added 
after a base model is created. (LNG Tank> Add Loading> Wind…) 

 

Fig 19 User Input for Wind Load for a Base model for design check 

Other Options 

Half Only Model 
A half model is produced with symmetrical support conditions when the ‘Half only 
model’ option is selected. 
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Fig 20 Option for Half Model 

 

Fig 21 3D Shell Model (Half Model) 
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Loadings 
28 loadcases are defined for the base model for design check. 

 

Fig 22 Loadcases Available in a Base model for design check 

Self Weight 

 

Fig 23 Self Weight in a Base model for design check  
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Dead Loads of Steel Structure 
The dead load of the steel inner tank is defined including wall plate, secondary bottom, 
bottom plate, annular plate and suspended deck.  

 

Fig 24 Dead Loads for Steel Structure in a Base model for design check  

Dead load of liner and steel roof 
The total weight of the roof plate and frame need to be specified to design the roof. 

 

Fig 25 Dead Load of Liner and Steel Roof in a Base model for design check  



Build Base Model 

21 

Dead load of steel structures on the roof 
For the design of the outer tank, the loadings due to the steel structure on the roof as 
well as the pipe work on the roof should be considered as distributed load on the roof. 

 

Fig 26 Dead Load of Steel Structures on the Roof in a Base model for design check  

Dead load of Insulation 
All insulation to the base, wall and suspended deck are defined.  

 

Fig 27 Dead Load of Insulation in a Base model for design check  
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Pressure on outer tank wall due to insulation 
The insulation (e.g. loose fill perlite) in the region between the inner tank and outer 
tank is assumed to exert a horizontal loading on the outer tank.  

 

Fig 28 Insulation Pressure Load in a Base model for design check  

Wall Piping Loading 
Wall piping loading acts on the outer surface of the ringbeam and wall.   

 

Fig 29 Wall piping loading in a Base model for design check  
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Liquid bottom (Max/Min) 
The Liquid weight acts on the top surface of the base slab. 

 

Fig 30 Liquid Bottom Loading in a Base model for design check  

Gas Pressure(Max/Min) 
Design gas pressure acts on the inner surface of the concrete tank.  

 

Fig 31 Gas Pressure Loading in a Base model for design check  
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Live load (Imposed Load on the roof) 
Live Load (Imposed Load on the roof, ref. EN 14620-1) is assigned on the top surface 
of the roof.  

 

Fig 32 Live Load in a Base model for design check (Roof)  

Snow load  
The snow load is assigned on the top surface of the roof.  

 

Fig 33 Snow Load in a Base model for design check (Roof)  
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Test load (Liquid bottom) 
The Test load (Liquid bottom) acts on the top surface of the base slab.   

 

Fig 34 Test Load (Liquid Bottom) in a Base model for design check  

Test load (Pneumatic) 
Test load (Pneumatic) acts on the inner surfaces of the concrete tank.  

 

Fig 35 Test Load (Pneumatic) in a Base model for design check  
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Prestress Load 
The effect of the prestressing steel tendons needs to be converted to equivalent external 
load and used for the input in the Wizard. 

 

Fig 36 Prestress Load in a Base model for design check  

Analyses 
Five analyses having a total of 66 loadcases are set-up in the model. 

 Base Analysis A static analysis. A total of 28 loadcases are provided including 
4 temperature loading which can be added from a separate Thermal Analysis. 
Loadcase for wind load is not created when Base model is built. However, it can 
be added using ‘Add loading> Wind…’ 

 Seismic Analysis Equivalent peak seismic acceleration and hydrodynamic 
loading are to be added.  

 Staged Construction Analysis 29 construction stages are defined with self 
weight only if ‘Roof split 1’ is set for Roof construction plan.  

 CRSH Analysis CRSH analysis is not created when Base model is built. 
However, it could be added using ‘Add loading> Creep and Shrinkage’ menu. 
The same number of loadcases for Staged construction analysis will be created. 
As for Staged Construction Analysis, combinations have been added to consider 
the pure effect from Creep and Shrinkage alone. This is obtained by subtracting 
the results in Analysis 5 (including CRSH) and the results in Analysis 4 (not 
considering CRSH). 

 Eigenvalue Analysis To obtain Eigenvalue results. 
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Fig 37 Analyses Available in Base Model 

Roof element layers 
The roof is built in two layers. Hence, two sets of overlapping surfaces have been 
created to consider the staged construction. As only the final layer is required for the 
other analyses, one set of surfaces is deactivated for the 1st loadcase of Base Analysis, 
Thermal Analysis, Seismic Analysis, and Eigenvalue analysis. 

Loadings 
Self weight is assigned in all analyses. 

• In the Base Analysis, 28 loadcases are provided, including 4 temperature 
loading. 

• In the other analyses (with the exception of the self weight) loading is not yet 
assigned. 

Base Load Combinations 
As seen in [Fig 63], 17 load combinations are pre-defined. These combinations are 
used to obtain the isolated effect of adding loading from a Staged Construction 
Analysis, so that they can be used as a single loadcase in the design load combination. 
A staged construction analysis is nonlinear by definition and hence the principle of 
superposition is not generally applicable. However, this simplified approach provides a 
systematic and efficient way of verifying hundreds of load combinations in the context 
of linear design according to a code of practice. 
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For example, the load combination of ‘WO Roof Ringbeam 1st PS ONLY’ is for the 
subtraction of ‘Ringbeam[Staged]’ from ‘Ringbeam 1st PS[Staged]’.  

1) Ringbeam[Staged] : Wall & Ringbeam is built. (i.e. no roof) 
2) RingBeam 1st PS[Staged] : Wall & Ringbeam is built. (i.e. no roof). 1st PS 

is added. 
Both loadcases are included in the Staged Construction Analysis, and the combination 
of 2)-1) is used to obtain the effect of the 1st PS loading during the construction stage. 

 

Fig 38 Pre-defined Load Combinations - WO Roof 1st PS only 

Template for load combinations 
A template for use in defining design load combinations is saved in the current working 
folder with name of the form: <Model name>_ComboTemplate.xlsx. 

Update Reinforcement and Prestress 
If the reinforcement or prestress tendon arrangement needs to be updated after the 
model is built, it can be updated by selecting the menu item LNG Tank > Design 
Checks> Add/Update Reinforcement…  

This only updates the existing properties. If the attribute is to be de-assigned or deleted, 
it should be done manually. 

If one-side only rebar is required, use a negligible value for Es. (e.g. a very small value
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Thermal Analysis 
Thermal analysis that requires the evaluation of heat transfer through thickness cannot 
be performed with shell elements, so a thermal analysis using 2D axisymmetric solid 
elements is required instead. 

Thermal Analysis for Max Environmental Temperature 
Select the LNG Tank > Create 2D model> Thermal Analysis… menu item, and 
assuming the default inputs are for maximum temperature, perform a 2D Thermal 
Analysis with the input data of ‘Tnk1 – Max Temperature’  

• Enter Example - Max for the model file name, and click OK. 

 

Fig 39 Dialog for Thermal Analysis (Max) 
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The current shell model will be closed and a new 2D axisymmetric solid model suitable 
for thermal analysis will be built. 

 

Fig 40 Thermal Analysis for Max Environmental Temperature 

• Solve the model, and in the Analyses  treeview, set the loadcase Operating 
Condition (Thermal) active.  

The Equivalent Uniform Temperature and Linear Temperature Gradient through 
thickness can be computed and saved in a spreadsheet by selecting the menu item LNG 
Tank > Excel Tools> Export Temperatures… 

 

Fig 41 Extraction Thermal Max Results 



Thermal Analysis for Min Environmental Temperature 

31 

In the current working folder, the file ThermalResult-Max.xlsx containing the 
extracted results for Roof/Slab/Wall is created. 

 
 

 

Fig 42 Extracted Thermal Results in a Spreadsheet 

Thermal Analysis for Min Environmental Temperature 
To perform additional thermal analyses for a minimum environment temperature, re-
select the menu item LNG Tank >Tank Definition… 
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Fig 43 User Input for Min Environmental Temperature 

• Enter 10 (Celsius) for both the External Temperature and the Initial 
Temperature (Soil). The Initial Temperature (Structure) is the temperature 
at the time when concrete is poured, hence there is no need to change at the 
moment.  

• Save these inputs with name ‘Tnk2-Min Temperature’. 

• Select the menu item LNG Tank > Create 2D Model> Coupled Thermal 
/Structural… and enter Example - Min for the model file name, then click 
OK. 
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Fig 44 Dialog for Thermal Analysis (Min) 

• Solve the model, and in the Analyses  treeview, set the loadcase Operating 
Condition (Thermal) active.  

• Export results into a spreadsheet by selecting the menu item LNG Tank > 
Excel Tools> Export Temperatures…  

 

Fig 45 Extraction Thermal Min Results 
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Update Base Model 
The thermal analysis results can be converted to 3D loading for load combinations. 

• Close the thermal model, and open the shell model of 
‘Example(CodeChecking).mdl’. 

• Select the menu item LNG Tank > Add loading> Thermal … then select the 
spreadsheets for thermal analysis results and click OK. 

 

Fig 46 Dialog for Adding Thermal Loading 

The thermal analyses results are converted into equivalent structural temperature 
loadings in the 3D shell model. 

 

 Fig 47 Temperature Loading from Thermal Analyses
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Seismic Analysis 
Preparation 

A seismic analysis considering fluid-soil-structure interaction under seismic action 
should be carried out prior to the 3D shell model investigation. The inertial and 
hydrodynamic peak effects obtained from a seismic analysis can be transformed to 
equivalent static loading for a 3D model in the form of accelerations that will act on the 
structural masses and other structural loadings. 

Update Base Model 
Both OBE and SSE loadings can be defined by selecting the menu item LNG Tank > 
Add Loading> Seismic…  
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Fig 48 Dialog for Adding Seismic Loadings 

Horizontal Loadings 
Based on the given inputs, the loadings are defined as shown below. The acceleration 
loadings are directly used for defining Body Force loading in Modeller, and the other 
loadings are converted to equivalent structural loadings.  
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 Fig 49 Horizontal Seismic Loading for Roof (SSE) 

 

 Fig 50 Horizontal Seismic Loading for Wall (SSE) 
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 Fig 51 Horizontal Seismic Loading for Base Slab (SSE) 

 

 Fig 52 Horizontal Seismic Loading of Liquid Force (SSE) 

 The force of the liquid is transferred to the Base Slab through the inner tank, so 
the loading is applied at the location of the inner tank wall. 

 The total force defined from user input is 500E3 kN in the global X direction, 
however the pressure of the liquid acts perpendicular to the inner tank wall 
surface with an intensity following a cosine variation. 

 A cylindrical local coordinate system is applied to the lines to ensure loading is 
in a radial direction. 
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 Fig 53 Horizontal Seismic Loading of Overturning Moment from Base Slab (SSE) 

 

 

Fig 54 Horizontal Seismic Loading of Overturning Moment from Inner Tank (SSE) 

 

Vertical Loadings 
The acceleration loading is directly used to define Body Force loading in Modeller 
except for the acceleration for the Inner Tank. As the Inner Tank is not included in the 
meshed model, the loading is converted to equivalent structural loading.  
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 Fig 55 Vertical Seismic Loading for Roof (SSE) 

 

Fig 56 Vertical Seismic Loading for Wall (SSE) 
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 Fig 57 Vertical Seismic Loading for Base Slab (SSE) 

 

 Fig 58 Vertical Seismic Loading for Inner Tank (SSE) 

 The inner tank is not included as structural elements, so the vertical loading 
from the inner tank should be converted for structural loading.  
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 Fig 59 Vertical Seismic Loading for Liquid (Hydrostatic, SSE) 

 The given liquid pressure is 400E3 kN is converted as a distributed load for 3D 
model.  

 

Fig 60 Roof Frame1 Loading 

As these loadings are not permanent loading, they are not inherited by the subsequent 
stages and are marked as ‘temporary’ in the loadcase name. 
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Fig 61 Stage 9 of Staged Construction Analysis 

Stage 9 assumes that the inner tank has been built. All insulation loading except for 
‘Roof Liner’ will be defined and assigned at this stage.  

  
 

 

Fig 62 Stage 12-14 of Staged Construction Analysis 

Stage 12 assumes that the roof is being built and the poured concrete is acting as a 
loading on the ringbeam.  
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Fig 63 Stage 12 of Staged Construction Analysis 

Stage 13 assumes that the roof is completed (Roof ratio for 1st built is set to 1.0. As 
shown below. At this stage the wet concrete loading assigned at Stage 12 is removed 
and replaced with the body force of the Roof. 

 

Fig 64 Roof Shape at Stage 13 

 

Fig 65 Stage 15 ~ 16 of Staged Construction Analysis 
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Fig 66 Stage 15 of Staged Construction Analysis 

At Stage 15, 50% of additional RingBeam Prestress is added. (The Load Factor is 
updated from 0.5 to 1.0 for Horizontal Prestress_Ringbeam load.) 

  

Fig 67 Stage 18 ~ 19 of Staged Construction Analysis 

At Stage 16 the vertical prestress is added. 

At Stage 17 all the horizontal prestress for the Wall is added. 

Stage 18 is the final stage. The structures are complete as built, and all loadings for the 
operating condition are added. 

Stage 19 models long-term effects. The prestress values are updated to those for long-
term PS. 

• Single layered roof 2 

Stage Description Note 
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Stage Description Note 

No. 1 Annular part  

No. 2 1) + Base 1st PS  

No. 3 2) + Circular part  

No. 4 3) + Base 2nd PS  

No. 5 4) + Wall is added up in stages  

No. 6 5) + Ringbeam 1st   

No. 7 6) + Wall End 1st PS  

No. 8 7) + Ringbeam 1st PS  

No. 9 8) + Roof Frame 1  

No. 10 9) + Inner Tank Work  

No. 11 10) + Roof Frame 2  

No. 12 11) + Roof Frame 3  

No. 13 12) + Ringbeam  

No. 14 13) + Roof Wet Concrete  

No. 15 14) + Roof Complete 

 

 

No. 16 15) + Roof Inside Load  

No. 17 16) + Vertical PS  

No. 18 17) + Horizontal PS  

No. 29 18) + Final Short term  

No. 30 19) + Final Long term (Long term PS applied)  
Table 1 Sequence of Construction Stages  

• Layered roof option 1 

Stage Description Note 

No. 1 Annular part  

No. 2 1) + Base 1st PS  
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Stage Description Note 

No. 3 2) + Circular part  

No. 4 3) + Base 2nd PS  

No. 5~6 4) + Wall & Ringbeam is added up in stages  

No. 7 6) + Ringbeam 1st PS  

No. 8 7) + Roof Frame 1  

No. 9 8) + Inner Tank Work  

No. 10 9) + Roof Frame 2  

No. 11 10) + Roof Frame 3  

No. 12 11) + Roof Lower Wet Concrete  

No. 13 12) + Roof Lower Complete 

 

 

No. 14 13) + Roof Lower Inside Load  

No. 15 14) + Roof Upper Wet Concrete  

No. 16 15) + Roof Complete  

No. 17 16) + Ringbeam 2nd PS  

No. 18 17) + Vertical PS  

No. 19 18) + Horizontal PS  

No. 20 19) + Final Short term  

No. 21 20) + Final Long term (Long term PS applied)  
Table 2 Sequence of Construction Stages (Roof Ratio for 1st Built = 0.5) 
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Fig 68 Stage 1 ~ 4 of Staged Construction Analysis 

Stage 1 builds the annular part of the slab.  

Stage 2 adds the 1st PS for the Base Slab 

Stage 3 the central part of slab.  

Stage 4 adds the 2nd PS for the Base Slab.  

Stage 5 models the construction of the first lift of the Wall. 
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Note that self weight is always assigned when a new part of the structure is added. 
Loading defined and assigned at a stage is inherited by the subsequent stages.  

 

 

Fig 69 Stage 5 ~ 6 of Staged Construction Analysis 

At Stage 6, the Wall and RingBeam construction is complete. 
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Fig 70 Stage 7 ~ 11 of Staged Construction Analysis 

At Stage 7, 50% of RingBeam prestress is assumed to be applied if the ‘Initial 
prestress for Ringbeam (ratio)’ is set to 0.5. (A Load Factor of 0.5 was used for the 
Horizontal Prestress_Ringbeam load.) If ‘Initial prestress for Ringbeam (ratio)’ is 
set to a different value then the Ringbeam prestress at Stage 7 will have a different load 
accordingly.  

Stages 8, 10 and 11 assume that there could be temporary loads on the line where the 
roof and RingBeam are connected. The loadings for Roof Frame 1, Roof Frame 2 and 
Roof Frame3 are defined using user inputs. The user needs to input total loading and 
Modeller will automatically convert this to the equivalent load per unit length 
according to the length of line the loading is assigned to. 
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Fig 71 Roof Frame1 Loading 

As these loadings are not permanent loading, they are not inherited by the subsequent 
stages and are marked as ‘temporary’ in the loadcase name. 

 

Fig 72 Stage 9 of Staged Construction Analysis 

Stage 9 assumes that the inner tank has been built. All insulation loading except for 
‘Roof Liner’ will be defined and assigned at this stage.  
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Fig 73 Stage 12-14 of Staged Construction Analysis 

Stage 12 assumes that the lower half of the roof is being built and the poured concrete 
is acting as a loading on the ringbeam.  

 

Fig 74 Stage 12 of Staged Construction Analysis 
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Stage 13 assumes that the lower half of the roof is built (if Roof ratio for 1st built = 0.5 
from Tank Definition), and the lower part of the roof is newly activated. As shown 
below, the geometric properties used represent those for only half of the Roof at stage 
13, only becoming geometric properties for the whole roof at stage 16. 

Stage 13 assumes that the lower part of roof is completed. At this stage the wet 
concrete loading assigned at Stage 12 is removed and replaced with the body force of 
the lower part of Roof. 

 

Fig 75 Roof Shape at Stage 13, 16. 

   

Fig 76 Stage 15 ~ 16 of Staged Construction Analysis 
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Fig 77 Stage 15 of Staged Construction Analysis 

Stage 15 models the upper half of the Roof being built with the poured concrete acting 
as a load on the already cast lower half of the Roof.  

Stage 16 assumes that the upper part of the Roof is now built. The wet concrete loading 
assigned at Stage 15 is removed and replaced with the body force of the upper part of 
the Roof.  

At Stage 17, 50% of additional RingBeam Prestress is added. (The Load Factor is 
updated from 0.5 to 1.0 for Horizontal Prestress_Ringbeam load.) 

  

Fig 78 Stage 18 ~ 19 of Staged Construction Analysis 

At Stage 18, the vertical prestress is added. 

At Stage 19, all the horizontal prestress for the Wall is added. 
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Stage 20 is the final stage. The structures are complete as built, and all loadings for the 
operating condition are added. 

Stage 21 models long-term effects. The prestress values are updated to those for long-
term PS. 

If ‘Roof ratio for 1st built’ is set to 1, the following sequence for the staged construction 
analysis will be applied.  

• Layered roof option 2 

Stage Description Note 

No. 1 Annular part  

No. 2 2) + Base 1st PS  

No. 3 3) + Circular part  

No. 4 4) + Base 2nd PS  

No. 5~6 5) + Wall & Ringbeam is added up in stages  

No. 7 6) + Wall End 1st PS  

No. 8 7) + Ringbeam 1st PS  

No. 9 8) + Roof Frame 1  

No. 10 9) + Inner Tank Work  

No. 11 10) + Roof Frame 2  

No. 12 11) + Roof Frame 3  

No. 13 12) + Roof Lower Wet Concrete  

No. 14 13) + Roof Lower Complete 

 

 

No. 15 14) + Roof Lower Inside Load  

N0. 16 15) + Wall End 2nd PS  

No. 17 16) + Ringbeam 2nd PS  

No. 18 17) + Roof Upper Wet Concrete  

No. 19 18) + Roof Complete  

No. 20 19) + Vertical PS  
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Stage Description Note 

No. 21 20) + Horizontal PS  

No. 22 21) + Final Short term  

No. 23 22) + Final Long term (Long term PS applied)  
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Fig 79 Stage 1 ~ 4 of Staged Construction Analysis 

Stage 1 builds the annular part of the slab.  

Stage 2 adds the 1st PS for the Base Slab 
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Stage 3 the central part of slab.  

Stage 4 adds the 2nd PS for the Base Slab.  

Stage 5 models the construction of the first lift of the Wall. 

Note that self weight is always assigned when a new part of the structure is added. 
Loading defined and assigned at a stage is inherited by the subsequent stages. 

 

 

Fig 80 Stage 5 ~ 6 of Staged Construction Analysis 

At Stage 6, the Wall and RingBeam construction is complete. 
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Fig 81 Stage 7 ~ 11 of Staged Construction Analysis 

At Stage 7, 50% of Wall end 1st prestress is assumed to be applied (A Load factor of 
0.5 was used for the Horizontal Prestress Wall End 1st load).  

At Stage 8, 50% of RingBeam prestress is assumed to be applied if the ‘‘Initial 
prestress for Ringbeam (ratio)’ is set to 0.5. (A Load Factor of 0.5 was used for the 
Horizontal Prestress_Ringbeam load.) If ‘‘Initial prestress for Ringbeam (ratio)’is 
set to a different value then the Ringbeam prestress at Stage 8 will have a different load 
accordingly.  

Stages 9, 11 and 12 assume that there could be temporary loads on the line where the 
roof and RingBeam are connected. The loadings for Roof Frame 1, Roof Frame 2 and 
Roof Frame3 are defined using user inputs. The user needs to input total loading and 
Modeller will automatically convert this to the equivalent load per unit length 
according to the length of line the loading is assigned to. 
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Fig 82 Roof Frame1 Loading 

As these loadings are not permanent loading, they are not inherited by the subsequent 
stages and are marked as ‘temporary’ in the loadcase name. 

 

Fig 83 Stage 10 of Staged Construction Analysis 

Stage 10 assumes that the inner tank has been built. All insulation loading except for 
‘Roof Liner’ will be defined and assigned at this stage.  
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Fig 84 Stage 12-14 of Staged Construction Analysis 

Stage 13 assumes that the lower half of the roof is being built and the poured concrete 
is acting as a loading on the ringbeam.  

 

 Fig 85 Stage 13 of Staged Construction Analysis 
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Stage 14 assumes that the lower half of the roof is built (if Roof ratio for 1st built = 0.5 
from Tank Definition), and the lower part of the roof is newly activated. As shown 
below, the geometric properties used represent those for only half of the Roof at stage 
14, only becoming geometric properties for the whole roof at stage 19. 

Stage 14 assumes that the lower part of roof is completed. At this stage the wet 
concrete loading assigned at Stage 13 is removed and replaced with the body force of 
the lower part of Roof. 

 

Fig 86 Roof Shape at Stage 14 and Stage 19. 

  

Fig 87 Stage 15 ~ 16 of Staged Construction Analysis 

At Stage 16, 50% of additional Prestress for Wall End lot is added. (The Load Factor is 
updated from 0.5 to 1.0 for Horizontal Prestress_12LOT(Short) load.) 

At Stage 17, 50% of additional RingBeam Prestress is added. (The Load Factor is 
updated from 0.5 to 1.0 for Horizontal Prestress_Ringbeam load.) 
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Fig 88 Stage 18 of Staged Construction Analysis 

Stage 18 models the upper half of the Roof being built with the poured concrete acting 
as a load on the already cast lower half of the Roof.  

Stage 19 assumes that the upper part of the Roof is now built. The wet concrete loading 
assigned at Stage 18 is removed and replaced with the body force of the upper part of 
the Roof.  

   

Fig 89 Stage 18 ~ 19 of Staged Construction Analysis 

At Stage 20, the vertical prestress is added. 

At Stage 21, all the horizontal prestress for the Wall is added. 

Stage 22 is the final stage. The structures are complete as built, and all loadings for the 
operating condition are added. 

Stage 23 models long-term effects. The prestress values are updated to those for long-
term PS. 

If ‘Roof ratio for 1st built’ is set to 1, the following sequence for the staged construction 
analysis will be applied.  
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Stage Description Note 

No. 1 Annular part  

No. 2 1) + Base 1st PS  

No. 3 2) + Circular part  

No. 4 3) + Base 2nd PS  

No. 5~16 4) + Wall & Ringbeam is added up in stages  

No. 17 16) + Ringbeam 1st PS  

No. 18 17) + Roof Frame 1  

No. 19 18) + Inner Tank Work  

No. 20 19) + Roof Frame 2  

No. 21 20) + Roof Frame 3  

No. 22 21) + Roof Wet Concrete  

No. 23 22) + Roof Complete 

 

 

No. 24 23) + Roof Lower Inside Load  

No. 25 24) + Ringbeam 2nd PS  

No. 26 25) + Vertical PS  

No. 27 26) + Horizontal PS  

No. 28 27) + Final Short term  

No. 29 28) + Final Long term (Long term PS applied)  
Table 3 Sequence of construction stages (Roof ratio for 1st built = 1) 

User Updates 

Construction Sequence 
If required, additional loadings or stages can be added.  

To duplicate loading types within the Analyses  treeview, the Copy and Paste 
options can be used as shown below. This will create additional stages (loadcases) and 
include all loadings previously assigned to the copied loadcase. 
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Fig 90 Copy and Paste of Stages (Loadcases) 

The required activation/deactivation/loadings/support can now be assigned or removed 
for this stage. The loadings at other loadcases can be also copied and pasted in the same 
way if required. 

User Updates 

Loadings 
As discussed, at in the section titled Staged Construction Analysis, some loadings may 
need updated. 

Construction Schedule 
The duration (length of time) of each stage is set to 10 days by default for all stages. 
This should be updated to follow the actual construction schedule.  

Each stage uses a Nonlinear Control, and both the time and Total Response Time 
should be updated together.  

For example, if the time gap between Stage 6 and Stage 7 needs to be changed to 15 
days, Nonlinear Control for Stage 6 should be updated. 
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Default settings for Stage 6 are shown below.   

 

Fig 91 Nonlinear Control for Stage of Ringbeam (Default) 

 Initial Time Step : Analysis is performed at every 10 days. 
 Total Response Time : This stage lasts up to 60 days from the start of 1st Stage. 

 

The number of days that the current stage lasts for is the Total Response Time of 
current stage minus Total Response Time of the previous stage. 

By modifying Total Response Time to 65, this stage lasts for 5 more days. (e.g. a total 
of 15 days)  

Note that the Total Response Time for the subsequent stages should be also updated.  
Otherwise, the 7th Stage will last only 5 days. 

Modifying Initial Time Step is optional and depends on the accuracy required. With a 
smaller time step, the creep and shrinkage material properties are updated frequently 
(e.g. using smaller time gaps) hence the accuracy would increase, however the solution 
time will increase accordingly. 

Tip 
The unit of time is set on the Model Properties dialog by selecting the File > Model 
Properties menu item. 
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Fig 92 Model Properties 

Age 
The Wizard built model assumes that each member is activated at the same concrete 
Age. The Age property represents the concrete age at the time of activation. (i.e. the 
time gap between pouring the concrete and removal of formwork.) If a different age is 
required for some members, another Age attribute should be defined and assigned 
manually for those. 
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Design Load 
Combinations 

Template for Design Load Combinations 
The template for Design Load Combination is saved in the current working folder 
where the Base Model was built, with the name [Model name]_ComboTemplate.xlsx, 
as shown below. The template can also be downloaded from the Design Load 
Combination dialog.  

Load Factors Worksheet 

 

Fig 93 Template for Design Load Combinations, Load Factors 

 Loadcase Index  The numbers in this row are used to match a Modeller 
loadcase number with a loadcase and its associated details in this template. The 
row should contain a series of numbers with no duplication. 

 Code and Details  Code and Details are used for naming the combination data 
in Modeller.  

 Load Factors Load factors for each loadcase is defined here. 
 Others  All other data are for users reference, and not used for processing. 
 Loadcase to consider can be added. (more columns as necessary can be added.) 
 Load combinations can be added. (more rows as necessary can be added) 
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Loadcases Worksheer 
 

 

Fig 94 Template for Design Load Combinations, Loadcases 

 Loadcase Name  The loadcase names defined in Modeller. The loadcase 
number may change during the process of updating the model, so the loadcase 
name is used in the definition of the Load Combination. Note that the loadcase 
names used must be the same as the loadcase names defined in Modeller. 

 (LF) Column This column is used to match a Modeller loadcase to a 
corresponding loadcase on the LoadFactors worksheet by entering Loadcase 
Index on the LoadFactors worksheet. For example, the Self Weight loadcase in 
Modeller is used in the ‘Outer Tank Full’  combination defined in LoadFactors 
sheet. By entering 0 (zero), the loadcase is ignored and will not be used in the 
combination. 

 Others  All other data are for users reference only, and not used for processing. 
 

Update Base Model 
The template is imported into Modeller by selecting the LNG Tank > Design checks> 
Design Load Combination… 

 

Fig 95 Dialog for Design Load Combination 

 Template Download Downloads the template to be used for creating load 
combinations to the current working folder. 

 Combination data  Select the load combination template. 
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On re-loading this template, the Code and Details columns in the LoadFactors 
worksheet will be compared with combination names in Modeller and the load factors 
will be updated. If any new combinations are present, they will be added. However, 
any existing combinations will not be deleted. 

The design load combinations are created as shown below. 

 

Fig 96 Load Combinations Created in Modeller 
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Design Check 
COP Parameters 

Design code parameters can be defined by the selecting the menu item LNG Tank > 
Design Checks > Enable… 

 

Fig 97 Dialog for Design Parameters – EN1992-1-1 (2005) 

 Partial Factors for Materials: The partial factors for materials are defined 
based on Table 2.1N on EN1992.  For Persistent & Transient, 1.5, 1.15, 1.15 are 
given to γ c for concrete, γ s for reinforcing steel, γ s for prestressing steel 
respectively.  For Accidental, 1.2, 1.0, 1.0 are given. 

 Yield Stress of Reinforcement (fy) : Yield strength of reinforcing steel in MPa. 
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 Yield Stress of Tendon (fyp) : Yield strength of prestressing steel in MPa. 
 Elastic Modulus of reinforcement (Es) : Elastic Modulus of reinforcing steel 

in MPa. 
 Elastic Modulus of Tendon (Ep) : Elastic Modulus of prestressing steel in 

MPa 
 Roof concrete grade :  Concrete strength in MPa. 
 Wall concrete grade :  Concrete strength in MPa. 
 Base concrete grade :  Concrete strength in MPa. 

 Long term effect coeff. (αcc) : Long term effect coefficient (EN1991 only) 
 

 Max Concrete Compressive Strain  : Ultimate strain at concrete failure (ACI 
318-14 only) 

 Yield Stress of Reinforcement (fy) : Yield strength of reinforcing steel in MPa. 
 Yield Stress of Tendon (fyp) : Yield strength of prestressing steel in MPa. 
 Tensile strength of tendon (fpu) : Tensile strength of prestressing steel in MPa. 

(ACI 318-14 only) 
 Computation Target : The design check computations will be performed for 

the targets of 
• Default: The node at Y=0 and X>=0. 
• Selected: The nodes that user selected before opening this dialog 
• Visible: All visible nodes in Modeller. 

 fse is used and PS is being applied as an external loading 
- When ‘fse’ is specified in the reinforcement template and the PS being 

applied as external loading, the code-checking that creates the PM chart will 
double count the PS effect. 

- Ticking this option shifts the results to avoid double counting the PS effect.  

- When a loadcase (or load combination) does not have PS as external loading, 
this option should be disabled (unticked). 

- It makes no difference if ‘fse’ is not specified in the reinforcement template. 
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Fig 98 Dialog for Design Parameters – ACI318_14 

 Yield Stress of Tendon (fyp) : Yield strength of prestressing steel in MPa. 
 Tensile strength of tendon (fpu) : Tensile strength of prestressing steel in MPa. 

(ACI 318-14 only) 
 Max Concrete Compressive Strain  : Ultimate strain at concrete failure (ACI 

318-14 only) 
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Fig 99 Dialog for Design Parameters – GB5001-2010 

 Loading conditions : This is used to identify if the design values or the 
characteristic values of the materials should be used, in accordance with clause 
3.3.4; 

 Significance coefficient(γ_0) : In line with clause 3.3.2, the design loads are 
multiplied by the significance coefficient of the structure; 

 Uncertainty coefficient (γ_Rd)t : In line with clause 3.3.2, the design 
resistance should be divided by the uncertainty coefficient. Note that when 
“Seismic” is selected in the loading conditions droplist, this is renamed to 
“Seismic adjustment coefficient (γ_RE) 
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 Stability coefficient(φ) : This is defined in clause 6.2.15 and is used for the 
calculation of the pure compression capacity in accordance with that same 
section; 

 Conventional reinforcement type: Based on the reinforcement type selected, 
the elastic modulus and yield strengths of the conventional reinforcement are 
calculated 

 Prestressed reinforcement type : Based on the prestressed reinforcement type 
selected, the elastic modulus and yield strengths of the tendons are calculated 

 Area of shear reinforcement per surface area(mm2/m2):  
 Concrete grade for roof/wall/slab: This was added, since [C1] defines the 

design concrete strength (Table 4.1.4-1) based on the concrete grade 
 Axial stress tolerance (% of fc):  

 

 

• Shifted force, Pi’      = Pi – fse * Apd 
• Shifted moment, Mi’ = Mi – fse * Apd * ecc_ps 

Design Checks for Tank 
Once design code parameters have been defined and the OK button is pressed a Tank 
Design Entity will then be available for selection in relevant result processing dialogs. 
The associated available components are shown below.  
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Fig 100 Components for Design Checks 

Whenever a results component is chosen, or a loadcase is set active, the design check 
for a selected component will take place. Design checks are carried out on a node-by-
node basis using analysis results and relevant design code formulae. 

UtilPM  (PM Utilization) 
UtilPM can be checked with reference to a PM chart, as illustrated below. A value of 
less than 1 means it satisfies the design code. 

 

Fig 101 Definition of UtilPM 
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 UtilPM_t is the force and moment utilization in the hoop direction, and 
UtilPM_rz is the utilization in  the radial direction for the Roof and Base Slab 
and for the vertical direction for the Wall.  

 Pcapacity_t and Pcapacity_rz is for the computed Pc at the given P1/M1 slope,  
Mcapacity_t, Mcapacity_rz is for the Mc at the given P1/M1 slope. 

 

  

Fig 102 Contour for UtilPM_t, UtilPM_rz 

UtilDC (Decompression Utilization) 
UtilDC aims to check if 25mm of concrete around a tendon is in compression. UtilDC 
is only available if EN1992 is chosen, and a value of less than 1 means it satisfies the 
design code.  

The UtilDC calculation assumes the stress distribution through the thickness is linear. 
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Fig 103 Zc for Decompression Check 

The tendon cover (dp) is the distance from outer surface to the tendon surface.  

When the section is fully in compression the maximum value is set to 100. (ie. if 
Zc<=0.25mm, UtilDC becomes 100.) 

UtilDC = Zdec / Zc = 25 / Zc. 

 UtilDC_t is the tendon and stress utilization in the hoop direction, and 
UtilDC_rz is the utilization in the radial direction for the Roof and Base Slab, 
and in the vertical direction for the Wall. 

 

UtilDC is only available for sections that contain prestress tendons. In the hoop 
direction, UtilDC_t is available for Wall and Slab. In the radial and vertical direction, 
UtilDC_rz is available only for Wall. 
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Fig 104 Contours for UtilDC_t, UtilDC_rz 

If concrete at the prestress tendon location is in tension UtilDC is set to 100. 

ShearResist (Shear Resistances) 
Shear capacity for the tank components is based on concrete shear resistance as per 
COP specifications. 

  
Fig 105 Contour for ShearResist_t, ShearResist_rv 

UtilShear (Shear Utilization) 
Shear utilisation factors are given as the absolute ratio between the shear forces (Sp, St, 
Sz, Sr) and the relevant shear resistances (ShearResist_t and ShearResist_rz). A value 
for UtilShear > 1 denotes failure in shear.  

  
Fig 106 Contour for UtilShear_t, UtilShear_rv 
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PM Chart Report 
A spreadsheet report that includes a PM chart can be produced by selecting the menu 
item LNG Tank > Design Checks> Design Check Report ... 

 

Fig 107 Dialog for Design Check Report with PM Chart 

 Report Target  The design check computations will be performed for the 
targets of 

• Default: The node at Y=0 and X>=0. 
• Selected : Any nodes that were selected before opening this dialog 
• Visible: All visible nodes in Modeller. 

 

If ‘Default’ is selected for Report Target, pre-defined target nodes will be used for each 
of the 15 types of different reinforcement arrangements in the current model, and the 
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report will contain 30 worksheets for producing PM charts for two directions 
(hoop/vertical or hoop/radial) for all 15 rebar arrangements. 

 

Fig 108 Design Check Report with PM Chart for Lot 1 

 Section Information at maximum thickness (1) The maximum thickness from 
the selected nodes is printed, for which the PM chart is displayed. 

 Section Information at minimum thickness (2) The minimum thickness from 
the selected nodes is printed, for which the PM chart is displayed. 

 Node  Node number for UtilPM computation 
 Element  Element numbers sharing the node 
 Group  Group name where the node is included in. 
 Thickness  Section thickness at the node location 
 Mi  Bending moment at the node 
 Pi  Axial force at the node 
 Mi’, Pi’  The shifted Mi, Pi when ‘fse is used and PS is being applied as an 

external loading’ option is ticked from the Design Code dialog. 
 UtilPM  PM Utilization 
 PM Chart  Two PM Charts are presented; one for the maximum thickness 

section, the other for minimum thickness section of the selected nodes. The 
value for Pcapacity in Modeller has different sign from the value of Pcapacity 
stated in the PM report 
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Design Checks for RC Slab 
Design checks for RC Slab is for concrete crack checks. By selecting the Design>RC 
Slab Design menu item, followed by an appropriate design code, a number of other 
design checks are available. For more information, please refer to the LUSAS user 
manual.  

  
 

 

Fig 109 Dialog for RC Slab Design and Result Components (1)  



Design Checks for RC Slab 

85 

 

Fig 110 Dialog for RC Slab Design and Result Components (2) 
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